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Trainer Notes Day 3  Agenda 
 

  Daily Diary, Email, Site of the Day 

  Diary Small Group/Whole Group Reflections 

  Searching the Web  
 

   Setting up a iKeep Bookmark Account 
 

  Creatures of the Deep 
 

         Comparing & Contrasting Creatures From the Deep 
 

  Assignments and Closing Remarks 
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Trainer Notes Day 3  Set-up Checklist 
 

 Check the following website for any resources, templates, etc. you may need to 
teach i3 training. http://www.i3forteachers.com/trainers/index.htm 

 Hide ocean creature cards under keyboards at each computer. 

 Send out email and site of the day to participants. 

 Check software:  Microsoft Word, Internet Explorer, Netscape, Kid Pix and 
MS Power Point 

 Check the Internet links that will be used for the day to make sure they are active. 

 Start computers and test log-ins. Check headphones and microphones 

 Update and start the Day 3 Kiosk on the Trainers workstation 

 Kiosk update should include dates of trainings, time of classes, lunch break, other 
breaks, and any other information that you want your participants to know. 

 Check the workstation desktops for the presence of the i3 participant folder. 

 Place post-it notes and pen at each workstation. 

 Place red cups at each work station – technology management strategy. 

 Hang the Grouping charts. 

 Group participants and hang names of group members under grouping charts. 

 Assemble Sign-in sheets. 

 Set out the crate for group folders. 

 Check paper and ink in printers. 

 Load music CD and have playing as participants arrive. 
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Good Morning – Day 3 – page 1 
 
Trainer Notes – Daily Activities 
Participants work on their own when they arrive in class for approximately 20 minutes.  
From the kiosk they will get their morning assignments: 

Email activity  
Daily diary reflection – Microsoft Word template  
Site of the day – found in email  
Use the student check sheet to check when assignments are complete.  Place work in 
folders. 

 
As participants finish the diary writing, they are to print two copies.  One is for the 
Trainer and one for their files.  Participants are to place yours in the group folder and 
check the task completed on the check-off sheet. 
 
Small Group / Whole Group Sharing of Daily Diary 

Move teams to small groups to discuss the diary reflection. 
Assign a leader of the group.  The leader will then report whole group.  Mark the 
leader on the Group Chart. 
Set a time limit for small group discussion. 
Trainer should walk from group to group listening to discussions and adding points. 
Small group leader will share responses with the whole group.   

 
Trainer Notes – Whole Group Sharing 

Daily Diary whole group sharing is an excellent time for the trainer to address 
concerns of the participants.  Be prepared to listen carefully and respond positively 
when necessary.  Don’t let this turn into a gripe session. 

 
Trainer Notes - Site of the Day –   
Following the Diary discussion the trainer should show the whole group the site/s of the 
day and talk about the teaching and learning aspects of each one. 
 
Daily Objectives: 

Learning to use the Internet for teaching and learning. 
Working with CD resources to locate information and create ebooks. 
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Good Morning & Welcome Back! 
Day 3 

 
 
You are on your own again this morning to complete 
the daily morning activities: diary writing, email and 
site of the day. 
 
1.  Open your diary template: 

" You can have anything you want 
If you will give up the belief that you 

can't have it."
Find the Training Resources folder on the 
desktop. 
Locate the Diary Template and double click on 
it to open it. 
Respond to the diary question in the slide show. 
Print 2 copies. Put one in your group folder and one in your notebook. 
Save your document as “Day 3 Diary” in your folder. 

 
2.  Check your E-mail: 

Open Netscape or Internet Explorer. 
Click in the location box and type the following address:  www.eudoramail.com (Press 
Enter) 
Click inside the Login Name box and key in your login name. 
Click inside the Password box and key in your password. 
Remember that your login name and password are written on the inside cover of your 
book. 
Click on Enter. 
Find the message from me, click on the underlined subject link to open it.  
Read and reply to my E-mail if necessary.  

 
 
3. View the “site of the day” How could you use this in your classroom? 
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Searching the Internet – Day 3 – page 2 
 
Trainer Notes – Searching the Web 
Discuss with participants the objectives of the lesson. 

Participant Objectives 
Locating information on the Internet. 
Understanding directories. 
Understanding search engines. 
Understanding meta-search engines. 
Learning to save graphics from the Internet. 
Learning to copy and paste text from the Internet. 
Learning to organize my favorite sites from the Internet. 

How do you know when you find material that it is accurate? Accept answers and discuss 
how information can be verified. Review from Day 1. 
Discuss saving web pages to hard drive and software that allows people to whack sites. 

• WebWhacker-  http://www.bluesquirrel.com/  
  

Searching the Web for facts and information can be tricky at times. Just because it’s on 
the Web does not make it true or accurate. Take a look at the false sites and discuss how 
easily students can be misled.  

• DHMO.org- looked through the site- FALSE site http://www.dhmo.org/  
• Also looked at the Jackelope Conspiracy- FALSE site 

http://www.sudftw.com/jackcon.htm  
• The Pacific Norwest Tree Octopus- FALSE site 

http://zapatopi.net/treeoctopus.html  
• Clones R Us- FALSE site http://www.d-b.net/dti/  
• "	California Velcro Crop is under challenge- FALSE site

          http://home.inreach.com/kumbach/velcro.html 	
              Also look at the list on the trainer site


 

Trainer Notes – Directories- Yahoo  http://www.yahoo.com 
Yahoo is a directory • 

• 

• 

• 

Organized in categories. You can browse categories much like a grocery store or you 
can conduct a specific search using keywords or phrases.  
Open a browser. (You can do this whole group to explain the process and then give 
participants hands-on ore have them go with you on their computers)   Go to Yahoo. 
Sometimes you may be looking for something but not know all the specifics. This is 
when a directory is nice. You can travel through the categories searching for what 
might be of interest to you.  
  Open Yahoo in your browser, and take participants through a guided browse. 
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Searching the Internet 
 
Why should you learn to search the Internet? 

There are literally millions of Web sites and the only way to find relevant information 
in this mass of data is to conduct a search. 

 
What resources are available to search the Internet? 

Web directories and search engines 
 
What are Web Directories? 

Web directories are indexes of Web sites categorized by subject.  They allow you to 
move through categories and subcategories until you find the information you need.  
Using a Web directory is similar to using the Yellow Pages.  Search directories are 
often the best places to begin a search, as they frequently yield more relevant returns 
on a topic than a search engine. 
 

 Yahoo!   http://www.yahoo.com 
 Yahooligans    http://www.yahooligans.com 
  
 
What are Search Engines? 

 Search engines are tools that search the Internet to locate matches to keywords or 
phrases that are descriptive of the information you are looking for.  Each search engine 
has its own unique features; therefore, a keyword will yield different search results in 
different search engines.  It is always a good idea to use more than one when you are 
trying to locate specific information. 
 

 AltaVista   http://www.altavista.com 
 Ask    http://www.ask.com 
 Ask  for Kids                  http://www.askforkids.com  
  
What are Meta Search Engines? 

Meta-search tools peruse several search engines at once, resulting in the top ten hits 
from several different search engines.   
 MetaCrawler   http://www.metacrawler.com 

 DogPile   http://www.dogpile.com 
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Searching the Internet – Day 3 – page 2 continued 
 

o Click on “History” under Arts & Humanities, U.S. History, By Subject, Military 
History, Wars and then Civil War.  

This will take you through several areas that might have information of interest to 
you based on what you are looking for.  
Go back to the Yahoo homepage and type “Civil War” into the search box.  

o You are now searching for the Yahoo database for any web page that has 
those words.  Notice you got about 1000 results returned to you.   

o Click the back button and talk about the importance of adding enough 
information in the search box to narrow down the search. Type in “civil war 
battles” and click search. Notice you now have about 200 links. Be clear about 
what your results mean. You have about 200 links that have the word “civil”  
“war”  “battles” on the page somewhere. It is likely that most of the links you 
will get will be about “Civil War battles” but some may just have those words 
on the page. 

Pass out sheet from SeirTec searching the web handout. This handout gives an 
overview of how different search engines work. This will enable you to design a 
search that is appropriate to the search engine.  
Make it clear that every search engine is different and has its own way of 
conducting a search of its database.  

 
Google  http://www.google.com  
For Google see page 3 - day 3 Trainer Notes. 
 Dog Pile  www.dogpile.com 
Last type of search engine we will look at is a Meta search engine. Dog Pile is a Meta type 
search engine.  It searches other search engines.  

• Go to the Dog Pile search engine, Click on the advanced search engine area. Talk 
about how the advance search area facilitates a better search. Review the specific 
tools. Type in “civil war battles” review what is found. 

 
Copyright links – see www.i3forteachers.com/copyright.htm 
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Notes Page 
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Google Advanced Search – Day 3 – page 3 
 
Trainer Notes – Google Advanced Search – Software Helper 
A step-by-step guide to using the advanced searching components of Google.   

Have participant’s type in www.google.com in their open browser. 
Red cups up when they see Google site open on their computers. • 

• 

• 
• 

• 
• 

• 

• 

• 

Trainer should talk to the participants about what is available on the site and what 
can be searched. 
Divide group in half. One group types in “civil war” and the other “civil war battles” 
Review the results. Have participants add words to their search strand at the top to 
narrow down the results. Give them optional words like, “3rd grade”, “lesson plans”, 
‘north”, “generals”. 
Review what the participants are getting based on changing the search strand. 
After finding a link that you like, go back to your Google search page and click on 
“Similar Pages” link next to that item. This will conduct a new search for only Web 
sites like the one that you liked. This is a great tool for narrowing your search.  
Go back to Civil War Battles 

o Google grades web sites by how many sites link to it.  In other words, what 
Google has done is gauged the quality of the site by its popularity. This 
method seems to be better than someone else doing an outside evaluation 
because you have multiple people choosing the site based on their evaluation. 
With Google you have a built in rating system.   

Review the “Advance Search” function of Google. I recommend this for all beginning 
searchers because it breaks down the process for them.  Review the search 
category break down and how to fine-tune your search.  

o Exact phrase 
o Without words 
o Format, Date, Domain  

Find PowerPoint’s about Civil War Battles 
 

Trainer Notes -  
Google Tricks 
Cached: Google takes pictures of all web sites and stores.  If the site is down you will still 
be able to pull up the information you are looking for.  
Google Image Search: Be careful doing this in front of your students.  You don’t know 
what you will get. 
Plagiarism: Finding out who wrote that paper. Go to Google type in exact phrase from a 
students paper that you expect was plagiarized. See if it returns any results.  
Show the kids that you can do this.  They will know how you can catch them. 
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Google Advanced Search 
Software Helper 

Getting Started 
To Open the 

Advanced Search 
Window 

• Click on Advanced Search on www.google.com. 
• The top four fields in the blue box replace Boolean searches. So 

instead of having to construct searches using the + or – symbols, 
Google’s Advanced Search fields performs those functions. 

 
To Broaden a Search • In the search field next to “with all of the words” type the word(s) 

you wish to search for and then press Google Search. 
• Google will return pages with all the terms you list in the search 

results. 
• Another option would be to put the main term in the top field and 

then list possible additional terms in the field next to “with at least 
one of the words”. 

• In this case Google will look for the top term and include as many of 
the other terms as possible in the search results. 

 
To Narrow a Search • In the search field next to “with all of the words” type the word(s) 

you wish to search for and then press Google Search. 
• In the field next to “without the words” type the words that should 

be excluded from the search, then press Google Search. 
 

To Search for a 
Phrase 

• In the field next to “with the exact phrase” type the phrase you 
wish to look for and then press Google Search. 

• Google will conduct a complete text search looking for the words in 
the phrase. 

Interpreting Search Resul s t
Indented Results • If more that one page from a site fits the search criteria, the 
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most relevant page is listed first with the other pages indented 
and listed below it. 

 
Viewing Missing Web 

Pages 
• Google’s search results include the title of the web page, the 

description of the web page and the URL to link to it. 
• Google also keeps a copy of the web page for itself. If the page 

is no longer available, click on cached next to the URL to open 
and use Google’s copy of the site. 

 
 Finding Similar Pages • If one of the results is exactly what you want, click on Similar 

Pages, next to cached, to pull up other pages like the one you 
selected. 

Additional Advanced Search Options 
Choosing a Language • The Advanced Search will return pages in any language.  

• To restrict results to one language, click on the down arrow 
next to that field and select the language. 

 
Selecting File Format 

Options 
• A powerful option in the advanced search is to restrict the 

search to a specific file format or to exclude that format from 
a search. 

• With the first down arrow next to the File Format field select 
Only or Don’t. 

• Then click the down arrow next to the second field to search 
for a specific file format. 

 
To Limit the Date  • If you are searching for material and would like to limit the 

results to only the most current or updated pages, use the Date 
field.  

• The down arrow, next to the date field, allows users to limit 
the search to a time frame for when the page was last updated. 

 
To Restrict a Search • The occurrences field allows users to tell Google where to look 

for the terms listed in the search boxes 
 
Using the Domain Feature • Using the domain features allows users to restrict a search to 

specific web site or type of site. For example, limiting a search 
to URL’s that end in edu will return results that are identify 
themselves as being a school. 

 
Filtering • Google provides the option to use a filter on searches to 

eliminate unwanted to material from the results. 
• Be aware that the filter is effective but not perfect! 
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How to Save Graphics from the Internet – page 5 
 
Trainer Notes – Saving Internet Graphics 
This is a software helper for participants to following when saving Graphics from the 
Internet. 
 
Participants will be saving a graphic of their sea creature during the Creatures From 
the Deep Lesson.  This is the step-by-step direction that the Trainer will use to take 
participants through the process. 
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How to Save Graphics from the Internet 
 

1. Find a graphic on the Internet that you would like to save. 
2. Right click on the image you would like to save and select Save Image As.  On the Mac 

just click and hold on the graphic and choose “copy to disk” 
3. Change to the appropriate drive.  A file name should appear.  Click Save.        
 
The graphic was either saved with a .GIF or .JPG extension.  In order to pull the graphic 
into some Windows programs (ClarisWorks 4.0, Student Writing Center, Kid Pix Studio), 
the file needs a .BMP extension.  You must open the file in a paint program which allows you 
to convert the graphic to a .BMP format.  Paint Shop Pro is one example of such a program.  
Conversion is unnecessary if your program will accept graphics with a .GIF or .JPG 
extension.  ClarisWorks 5.0, Kid Pix Studio Deluxe, and HyperStudio will allow you to use 
graphics with a .GIF and .JPG extension.  The change is not necessary if you are inserting 
the graphic into Microsoft Word. 
 
4. Minimize Netscape. 
5. Open Paint Shop Pro. 
6. From the File menu, select Open. 
7. Select the appropriate drive and click on the graphic you just saved. Click  OK. 
8. The graphic should appear on your screen. 
9. Under the FILE menu, drag down to SAVE AS. 
10. Change the List Files of Type box to .BMP - Windows Bitmap. 
11. Click OK. 
12. Look on the Title Bar. The graphic should now have a file name that ends in .BMP. 
13. File, Exit. 
 
You should be able to pull your graphic into other programs.  This is a great way to create a 
graphics folder for a theme or unit of study. 
 
* You should get permission to use any graphics that you save or copy from the Internet in 
order to comply with copyright laws. 
 
How to Copy/Paste Graphics from the Internet 

 
You must use Microsoft Internet Explorer in order to copy/paste graphics from the 
Internet. Netscape will only let you SAVE the graphics--not copy and paste them. 
 
1. Open Microsoft Internet Explorer.  
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How to save graphics from the Internet – Continued – 
Day 3-page 6 

 
Trainer Notes – saving graphics from the Internet continued 
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2. Locate the graphic you wish to copy. 
3. Right click on the graphic (on a Mac just click and hold).  A menu will appear. 
4. Choose Copy. 
5. A copy of the image is placed on the clipboard. 
6. Open the document in which you wish to paste the image. 
7. From the Edit Menu, choose Paste. 

 
Occasionally, using Internet Explorer to copy graphics from a PC results in a distorted 
image.  The colors don’t always paste into a document as they appeared on the Internet.  
In such cases, you should save the image from the Internet rather than copying and 
pasting.  You may then have to convert the graphic using Paint Shop Pro or some other 
draw program to a .bmp format in order to use it in your program. 
 
Copying and pasting is an easy way to get a quick graphic from the Internet.  If you’d like 
to create a graphics folder, you’ll need to save the graphics from the Internet rather than 
copying and pasting. 
 
* You should get permission to use any graphics that you save or copy from the Internet in 
order to comply with copyright laws. 
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How to Copy/Paste Text from the Internet –  
Day 3 - page 7 

 
Trainer Notes – Copying and pasting text from the Internet 
This is a step-by-step guide for copying and pasting text from the Internet. 
 
Participants learn this skill on day 2 with the fish poster activity. 
 
Copying and pasting is an easy way to get text from the Internet.   
 
Remember to follow copyright laws and give credit to the Web page from which you took 
the text.  See page 8 Day 3 for how to Cite Resources. 
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How to Copy/Paste Text from the Internet 
 

1. Open Netscape or Internet Explorer. 
2. Locate the text you wish to copy. 
3. Highlight the text. 
4. From the Edit Menu, choose Copy. 
5. A copy of the text is placed on the clipboard. 
6. Open the document into which you wish to paste the text. 
7. Click to plant the cursor where you would like to paste the text. 
8. From the Edit Menu, choose Paste. 

 
Copying and pasting is an easy way to get text from the Internet. However, you should be 
mindful of copyright laws and give credit to the Web page from which you took the text. 
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How to Cite Resources from the Internet –  
Day 3 - page 8 

 
Trainer Notes – Citing Resources from the Internet 
This is a resource from Classroom Connect that will help you and your students know how 
to cite Internet sources. 

 
Participants will need to use this resource during the Creatures From the Deep Lesson.  
 
This is the step-by-step direction that the Trainer will use to take participants through 
the process.
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How to Cite Resources from the Internet 
Classroom Connect developed the following method to help students cite Internet 
resources. 
 
1. World Wide Web 
Structure: 
Author. Title of item. [Online] Available http://address/filename, date of document or download. 
Example: 
Schwartz, Robert. The Cold War Revisited: A Splintered USSR. [Online] Available 
http://usa.coldwar.server.gov/index/cold.war/countries/former.soviet.block/, November 1, 1998. 

 
2. Email/LISTSERVs 
Structure: 
Author of email message. Subject line of the message. [Online] Available email: Student@address.edu 
from Author@address.edu, date of document or download. 
Example: 
Rule, Christopher. Nile River Research Project results. [Online] Available email: 
student5@smallvillehigh.edu from ert@informns.k12.mn.us, October 2, 1998. 

 
3. Images/Graphics 
Structure: 
Description or title of image. [Online] Available http://address/filename, date of document or download. 
Example: 
Butterfly. [Online Image] Available http://www.kidsdomain.com/holiday/spring/clip.html/ butterfly.gif, 
October 23, 1998. 
 
4. Sounds 
Structure: 
Description or title of sound. [Online Sound] Available http://address/file, date of document download. 
Example: 
Reflections on Apollo. [Online Sound] Available ftp://town.hall.org/radio/ 
IMS/NASA/100394_nasa_01_ITR.au, September 25, 1998. 
 
5. Video Clips 
Structure: 
Description or title of video clip. [Online Video Clip] Available http://address/file, date of download. 
Example: 
Shoemaker-Levy Comet enters Jupiter’s atmosphere and breaks up. [Online Video Clip] Available 
ftp://ftp.cribx1.u-bordeaux.fr/astro/anim/s19/breakingup.mpg, September 5, 1998. 
 

 
 

Source: Classroom Connect. October 1998, Volume 5, Number 2. 
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Setting Up an iKeep Bookmark Account – Day 3 - page 9 
 
Trainer Notes – Setting up an online bookmark account. 
This is a step-by-step resource that participants will follow to organize favorite 
bookmarks from the Internet.  
 
Use this step-by-step with participants to set up their own iKeeps bookmark account. 
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Setting Up a iKeep Bookmark Account 
 

1. Go to http://www.ikeepbookmarks.com by typing it in the location box of your 
Internet browser.  Press the Enter or Return key. 

2. Click on Click Here to Register.  

 
3. Type an account name. Your account name needs to be something that you can 

remember easily, such as the username that you use for your e-mail account. 
4. Enter an authoring password for your account.  You may want to use the same 

password that you use for your e-mail account so you can remember it. You will be 
asked to type the password a second time to confirm it. 

 
My Account Name: 
My Authoring Password: 
 

5. Click in the box next to Remember my Login to deselect that option on this 
computer if it is not a computer that you use exclusively. 

6. Choose Account Type from the drop down list. 
7. Click on Finished when you have completed the Contact Details at the bottom of the 

registration screen. The following screen will appear.  
8. Write the link to your account in your plan book or someplace so that you can get 

back to it easily. 
9. Click on option 2 to go to the home page for your account and to start adding links 

right away or option 1 to upload your links from your computer to your 
Ikeepbookmarks account. If you choose not to upload your bookmarks now, you can 
do so later. 

 
To Add Links to Your Account 
 
1. From the main page of your account click on Add. 
NEED AN IMAGE FOR THIS WITH AN ARROW 
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Setting Up a iKeep Bookmark Account – Day 3 - page 10 

 
Trainer Notes – Continuation of step-by-step helps on setting up a bookmark account. 
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2. The following screen will appear. Type the title of the link. Copy and paste the URL 

for the link into that field making sure that there are not two http://s in the field.  
A description of the link is optional but useful when the numbers of links grows.  

 
 

3. When the information for the link is complete, click Finished at the bottom of the 
entry screen. 

 
Notice that the links automatically appear in alphabetical order. From the main page, you 
can choose a different arrangement for your links by changing the drop down box next to 
the Add button for the links. 
To Organize Bookmarks 
 

1. From the home page click Add right underneath the words “These buttons, below, 
allow you to add or edit folders.”  The following screen will appear. 

 
2. Type the name of the folder and when you are done click Finished. You can create 

separate folders for classes, subjects or topics or any grouping that you can think 
of. 

3. To add links into a specific folder, open the folder first before clicking the Add 
button. 

4. Or, if you already have links that need to be organized, click the Edit button next to 
the list of existing links. 
 
Click in the empty box next to the title of the link. A green checkmark will appear. 
On the left-hand side in the gray box, change the Destination Folder to the one the 
link should move to then click on the Move button. 
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Setting Up a iKeep Bookmark Account – Day 3 - page 11 
 

Trainer Notes – Continuation of step-by-step helps on setting up a bookmark account. 
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When you are back at your home screen, a new number should appear next to the 
folder you moved links into. 

 
To Upload Bookmarks from a Computer 
 

1. On the top of the page, next to red Ikeepbookmarks.com logo, click on Bookmarks 
from the list of menu options. 

2. Two choices appear on the screen.  Click on Upload Bookmarks to the Web and the 
following screen will appear. 

 
 

 
3. Choose the first option to upload all the existing favorites from the web browser 

you are using to the bookmark folder. Simply click on the arrow and wait. A box will 
appear letting you know if it was successful. 

4. Other options on the upload page allow users to upload only  
new material or to replace existing bookmarks in the ikeep bookmarks account with 
the ones from the browser on the computer that you are using.  Choosing to use the 
replace option will wipe out your existing bookmarks in you account and put new 
ones from your browser in there.  

 
 

Optional Features 
 
The Options menu allows you to give people access to your bookmarks. Choose 
Options from the menu next to the red l Ikeepbookmarks.com logo at the top of the 
web page. Select a password for the visitor and set up the visitor’s access options. 
The Options menu will allow you to share your bookmarks without other people.  
 
The PopUp feature allows you to drag and drop links onto it while you are searching 
the web. Choose PopUp from the menu next to the red Ikeepbookmarks.com logo to 
find out how. 
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Creatures from the Deep – Day 3 - page 12 
 
Trainer Notes – Creatures from the Deep lesson plan 
Discuss with participants the objectives of the lesson, both participant objectives and 
student objectives: 
Participant Objectives: 

Locating information on the Internet and from CD ROMs. 
Publishing a story using multimedia software. 
Researching for background knowledge, synthesizing information and producing. 

Student Objectives: 
Determing the characteristics of living things. 
Learning the names of different living things from the ocean. 

 
Point out the state standards that are covered during this lesson.   
 
Trainer Notes – Materials Needed 

Sea creature names on colored paper at each computer station. 
Kid Pix software & Microsoft PowerPoint software  
Imagination Express:  Oceans CD 
Fact gathering sheet – page 16 - Creature From the Deep! 
Storyboard – page 17 – Creature From the Deep! 
Digital camera 
Handbook pages 18, 19, 20 

 
Techie Talk –  

Discuss CD use vs Internet use.   
Difference between installed CDs and CDs that run directly from CD. 
CD drives and floppy drives. 
CD care. 
Where to plug in headphones. 
Use of jack-box for group work. 
Windows Basic Skills Customizing the Desktop 

o Adjusting the Screen Resolution– How to change to 256 color. 
 Right Click on Desktop 
 Select Properties 
 Select Settings 

o Background 
o Review Picture Display 
o Screen Saver 
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Creatures of the Deep 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Questions for Teachers: How do I locate information on the 
Internet?  How do I use KidPix or KidWorks Deluxe to publish a story? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Essential Question: What are some characteristics of living 
things from the ocean?  What are names of different living 
things from the ocean?   
 
Learning Standards (State of Michigan): 
Assessed:  
English Language Arts Standard 3: Later Elementary  
Integrate listening, speaking, viewing, reading, and writing skills 
for multiple purposes and in varied contexts.  
 
English Language Arts Standard 3: Early Elementary  
Integrate listening, speaking, viewing, reading, and writing skills 
for multiple purposes and in varied contexts. Examples include 
using more than one of the language arts to create a story, write 
a poem or letter, or to prepare and present a unit project on 
their community. 
 
Science Standard I.1:Elementary 
Develop strategies and skills for information gathering and 
problem solving. ( Tools: Sources of information, such as 
reference books, trade books, periodicals. Real-world contexts: 
Seeking help from peers, adults, libraries, other resources.) 
 
Science Standard III.5: Elementary: 
Describe the basic requirements for all living things to maintain 
their existence. ( Key concepts: Needs of life-food, habitat, 
water, shelter, air, light, minerals. Real-world contexts: Selected 
ecosystems, such as an aquarium, rotting log, terrarium, 
backyard, local pond or wetland, wood lot.) 
 
Materials: Student reproducibles, Ocean software, Internet 
connection, word processing software. 
 
Technology Connections: 
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Creatures from the Deep –Day 3 - page 13 
 
Continuation of Techie Talk – page 12 

o Settings for the Screen Saver 
o Preview the Screen Saver looks on Desktop 
o Enlarge Desktop for Small TV Screen 
o Changing the Date and Time 
o Adjusting Computer Volume  

 
Trainer Notes – Talking points for the lesson. 

Participants are to locate their sea creature cards.  The cards will be used to group 
participants.  Step 3 page 13 Day 3 
The cards have been grouped by color depending on which family they are part of. 
This will make more sense once we get into the software. You can hand these out so 
that each team has equal representation of all families. This could be used later for 
jig sawing and/or expert groups. 
Participants will create 2 ebooks using Imagination Express and Power Point once all 
research is complete.  Trainer is to show the participants a sample ebook in 
Imagination Express – Oceans so that they know what the final product could look 
like.  Today, after gathering facts, participants will create individual pages of an 
ebook.  In a class setting teachers may have their students each create one or two 
pages of an ebook that will be compiled into a class book. 
Follow steps 5 and 6 - page 13 - Day 3. 
Participants are to place the Imagination Express – Oceans CD in the CD drive.  You 
will only be using the Fact Book on this CD at this point.  Note that the colors of the 
Mammals, Birds, Fish and Other ocean animals relate to the color of your sea animal 
name. 
Follow steps 7, 8, and 9 - page 13 - Day 3. Use your new searching skills to locate the 
needed facts and graphic for this assignment. Refer to the step-by-step guide on 
pages 5 and 6 – How to Save a Graphic.  You are working individually at this point.  
After using the cd for fact gathering participants will use their new searching 
strategies to find more detailed facts about their ocean creature. Participants will 
also copy and save a graphic of their creature from the Web. They will save the 
graphic to their desktop folder. 
Participants are given a time limit to complete the activity. 
Participants will create an ebook. 
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Teaching 
Strategies 
Modeled 
 
 
 
 
 
 
 
Whole 
Group 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Whole 
Group 
 
 
 
 
 
 
 
 
 
Individual 
Work 
 
 
 
 
 
 
 
 
 
 
 
 
 

Technology 
Strategies 
Modeled 
 
 
 
 
 
 
 
Internet 
 
Practical 
suggestions 
for using the 
Internet in 
your Elem. 
Classroom- 
http://www.t
echlearning.co
m/db_area/a
rchives/WCE
/archives/hee
se7.htm  
 
 
Imagination 
Express: 
Oceans CD 
 
 
 
 
 
 
 
 
 
 
 
Imagination 
Express: 
Ocean 
 
Ocean CDs 
 
Internet 
 
 
 
 
 
 

Grades 3-5: Students will gather information from the 
Internet and CD-Roms on selected living creatures from 
the ocean.  They will write a paragraph in a word 
processing program describing the living creature.   
Grades K-2: Students will gather information from the 
Internet and selected CD-roms and will create a story in 
Kid Works or KidPix. 

 
3-5 Procedures:   
Introduction- Whole Group 
1. Review Internet searching strategies.  Review Profusion, 

Yahoo, and About.com as search engines.   
2. Review copying a graphic from the Internet and from a 

CDRom. 
3. Distribute creatures of the deep name cards to all students.  

Students are in groups of 4.  Each group should have 1 card 
from group 1, 2 cards from group 2 and 1 card from group 3. 

4. Explain that students are going to complete several activities 
that will teach them more about living things from the ocean.   

 
Step 1- Gathering Ocean Background Information 
5. Show students, in a whole group setting, using the scan 

converter, the fact book in Imagination Express:  Oceans.   
6. Students are to listen to information on Oceans to gain a 

basic understanding of what can be found in the Ocean 
habitat. 

 
Step 2- Gathering Information on a selected creature 
7. Students will use the Creatures from the deep fact-gathering 

sheet to gather information on their selected living creature. 
8. Using Imagination Express: Ocean, selected Ocean CDs and 

the Internet facts should be located on the name of the 
creature, habitat, and at least 4 selected facts.  Sources of 
information are to be cited on the fact-gathering sheet. 

9. Capture a living creature graphic from the Internet.  Save 
this picture to the group folder on the server. 

 
 
Step 3- Writing about Creatures from the Deep 
10. Using the student storyboard, create a Creature from the 
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Creatures from the Deep – Day 3 - page 14 
 
Trainer Notes – Talking points continued for the Creatures From the Deep lesson. 

Prior to creating the ebook, participants are to complete the Storyboard on page 17.  
Students should always be prepared with their work prior to using the computer to 
produce a product. 
Take participants through the process of creating a title page in Imagination 
Express – Oceans 

Imagination Express Basics- Creating a ebook 
• Sign-in - Add Name (Switch - allows you to change student names.) 
• Choose a destination (Rain Forest, Castle, Neighborhood, Ocean, Pyramids, Time Trip 

USA). 
• Explain the main menu console (Fact Book, Story Ideas, Sample E-Book, Dear 

Parents). 
• Create a NEW E-book. 
• Choose a background. 
• Type in text. (Click on the text tool (A) and type in the paragraph.) 
• Change the font, color, justification, and size. 
• Choose a text border. (Click on the dotted-line rectangle to place text directly on 

the background or click on one of the leaves for a  decorative border.) 
• Add stickers, move a sticker, and delete a sticker. 
• Edit a sticker using the Sticker Editor. 

o Change the height, direction or size of the sticker 
o Add sound and animation 

• Add music to the page by clicking on the sound icon on the bottom toolbar. 
• Record the paragraph by clicking on the sound icon on the bottom toolbar.  

Microphones will be needed if you do this step. 
• Page Manager - Create a New page, delete a page, reorder pages, and view a small 

version of your E-book. 
• View a story - Ctrl E - toggles you back and forth from viewing to editing mode. 
• Viewing options: 

o Turn the page manually by clicking the arrows. 
o Play all sticker animations for the current page by clicking the button with 

the circles. 
o Play all pages automatically by clicking the play button with the 3 rectangles 

and 2 arrows. 
o Play page sound or movie by clicking the speaker. 

• Print - Hold down Ctrl to select a printer. Click on the Printer icon to print. 
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Teaching 
Strategies 
Modeled 
 
Group Work 
 
 
 
 
 
 
Peer Editing 
 
 
 
 
 
 
 
 
 
Whole 
Group 
 
 
 
 
 
Whole 
Group Demo 
 
 
 
 
 
 
 
 
 
 
Group 
Discussion 
 
 
 
 
 
 
 
 
 
 

Technology 
Strategies 
Modeled 
 
 
 
Imagination 
Express 
 
 
 
 
 
 
 
 
 
 
Imagination 
Express: 
Oceans 
 
 
 
Internet- 
http://www.E
nchantedLear
ning.com/Dict
ionaryA.html 
 
 
 
Practical 
suggestions 
for using the 
Internet in 
your Elem. 
Classroom- 
http://www.t
echlearning.co
m/db_area/a
rchives/WCE
/archives/hee
se7.htm  
 
 
 
 
 
 
 
 

Deep 3 page story.   Each story is to include a title page, and 
2 pages with supporting facts.   

11. Students will complete the e-book with backgrounds, graphics 
and animations from Imagination Express. 

12. Allow students to peer edit before printing their work. 
13. Evaluate students’ work on the project with this checklist.  

Print and copy for each student. 
http://pblchecklist.4teachers.org/view.php3?id=2471 

 
K-2 Procedures: 
 
Introduction 

1. Students are to listen to the Ocean facts in Imagination 
Express: Oceans. 

 
Creature Information  

2. Using a scan converter, show students the Little Explorers 
Dictionary on the Internet at 
http://www.EnchantedLearning.com/DictionaryA.html.  

3. Show students how to navigate through the site, clicking 
on the alphabet buttons at the top of the screen, and 
using the scroll bar on the side. 

4. Show students how to locate a word by clicking on the 
correct beginning letter and scrolling down to find the 
word. 

5. Assign each student a computer in the lab and give him or 
her a “Who am I?” Sheet. 

6. Explain that you will call out a riddle from the list that 
follows, students will go to the correct dictionary page on 
the internet and scroll down to find the ocean animal you 
described.  When they find it, they should raise their 
hand.   

7. Call on one student to give the answer and spell the word 
for the class.  Each student needs to write the word in the 
appropriate place on the answer sheet. 

8. When you are finished with the riddles, ask students to 
locate another ocean animal and write their own Who am 
I? riddle at the bottom of the page. 
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Creatures from the Deep – Day 3 - page 14 continued 
 
Trainer Notes – Talking points continued for the Creatures From the Deep lesson. 

Participants are to create a 3 page ebook. 
While participants are working on their ebooks, trainer is to walk around the room 
taking individual participant pictures with digital camera.  Trainer should save these 
pictures on a network drive in a named folder. 
Students are to evaluate their completed ebooks  – Step 13 – page 14 Day 3. Have 
participants walk around and view other participants’ ebooks.  

 
Power Point Basics- Creating an ebook 

Participants will open the Training Resources folder and open the ebook Template. 
Participants will use this template to complete the ebook assignment. They are using 
the information from their storyboard on page 17. After they have finished they 
will then follow the next steps to create the template.  

 
Creating an ebook template in MS Power Point 

Open MS Power Point 
Depending on the version of Power you have you might get a pop-up window that asks 
you what type of slide you want. Or this window may appear on the right side of your 
screen. Either way choose “Title page” 
Click in the top box to add a title. 
Click in the box below it to add student name. teacher name and date. 
Click on the “Insert menu and choose “new slide” click on “blank slide” 
Now we will introduce our creature on slide 2 which will be Page 1 of the ebook.  
Click on “Insert” and choose “picture” and then choose “from a file” 
Find the graphic you saved from the internet and insert it. Use the handle bars to 
resize the image so that it sits on in the top half of the page.  
Click on the insert text box icon on the drawing toolbar.  
Move your cursor up to the slide and click –hold-and –drag a text box below the 
graphic. This will create a text box on your slide that you can type information into. 
Resize the box by clicking and holding on one of the handlebars, drag to desired 
size. 
Add information from storyboard. 
Click on the “Insert menu and choose “new slide” click on “blank slide” 
Click on “Insert” and choose “text box”  
Move your cursor to the slide and click –hold-and –drag a text box. This will create a 
text box on your slide that you can type information into. Add other facts about 
your creature 
Click on “Insert” and choose “picture” and then choose “Clip Art” 
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Teaching 
Strategies 
Modeled 
 
 
 
 
 
Center 
Activity 

Technology 
Strategies 
Modeled 
 
 
 
 
 
 
KidPix 

Creatures form the Deep Facts 
9. Explain that students will now use what they have learned 

about ocean creatures in this center activity.   
10. In KidPix, use the paintbrush to draw an outline of an 

ocean creature.   
11. Have students go to the typewriter tool and create a text 

box in the center of their ocean animal.  Ask them to type 
a sentence about something they learned about an ocean 
creature. 

12. Ask students to stamp their name on the page, print it out, 
and check their name off of the center list. 

 
Assessment:  

Grades 3-5: Students’ completed projects will be 
evaluated by a checklist.   
Grades K-2: Students will be assessed on their answers 
to the riddles and their completed creature sentence. 

 
Extension:  

Grades 3-5: Have students add their ocean creature 
information to a one-computer station database on 
creatures of the deep.  This information will be shared 
with the entire class. 
Grades K-2: Have students write more riddles and let 
them quiz a partner using the same Internet site. 
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Creatures from the Deep – Day 3 - page 14 continued 
 

Search the clip art using ocean as a keyword 
Insert clipart of your choice. 
Click on the “Format” menu and choose “Background” 
Click on the upside down triangle and choose “fill effects” 
Choose 2 colors, horizontal and click OK 
Click on “Apply to All” 
Save your work to your folder. 

 
Trainer - End of Activity Discussion 

We completed a research activity utilizing the Internet with our searching skills, 
and various CD ROMs. 
We used this research to create an ebook.  We could have used the information to 
write a story or a paragraph.  The ebook could also have been created in KidPix or 
HyperStudio. 
When using software like Imagination Express that is new to students you have to 
be prepared to give them time to explore the “cool” tools.   
Two other products we are going to produce with this information are a riddle about 
your sea creature and a Venn diagram comparing and contrasting your sea animal 
with another participant’s sea animal. 
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Creature from the Deep! – Day 3 - page 16  
 

Trainer Notes – Data collection sheet for Creatures of the Deep lesson plan. 
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Creature of the Deep! 
 
Creature Family: 

 
Name: 
 
Source: 

 

Habitat: 
 
Source: 

 

Fact 1 
 
 
 
 
 
Source: 

 

General Fact 2 
 
 
 
 
 
Source: 

 

General Fact 3 
 
 
 
 
Source: 

 

General Fact 4 
 
 
 
 
Source: 
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Creature from the Deep! Storyboard – Day 3 - page 17 
 

Trainer Notes – Storyboard sheet for Creatures of the Deep lesson plan.  
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Creature of the Deep!  
Storyboard 

 
Title Page 

Title of Story:                                                                                     Date: 
 
Student Name: 
Teacher Name: 
 

Page 1 
 
Family Name: 
Name of creature: 
Habitat information: 
 
 
 
Fact: 
 
 
 
 

Page 2 
Supporting Facts: 
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Who Am I? – Day 3 - page 18 
 

Trainer Notes – Data collection sheet for the Who Am I? Riddle activity portion of the 
K-2 lesson. 
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Who Am I? 

 

T_________ P_________  
 
B_________ L_________ 
 
M_________ C_________ 
 
D_________ R_________ 
 
E_________ W_________   
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Teacher Clues – Day 3 - page 19 
 

Trainer Notes – Teacher clues for the riddle activity in the K-2 portion of the Creatures 
of the Deep lesson.  Teacher asks students the question listed on the teacher clues sheet.  
See steps 2 – 7 page 14 Day 3. 
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Teacher Clues  
 
1. My name starts with “T”.  I am a large fish that lives in the 

ocean.  People eat me.  Who am I?  Answer: Tuna 
 
2. My name starts with “B”.  I am a poisonous fish.  I’m also called 

a pufferfish.  Who am I?  Answer: Blowfish 
 
3. My name starts with “M”.  I am very large and I’m the fastest fish in the sea.  Who am 

I?  Answer: Mako Shark 
 
4. My name starts with “D”.  I am a small shark and I won’t hurt you.  Who am I?  Answer: 

Dogfish Shark 
 
5. My name starts with “E”.  I am a long, thin fish and I can make electricity.  Who am I?  

Answer: Electric Eel 
 
6. My name starts with “P”.  I am a meat-eating fish.  I live in South America.  Who am I?  

Answer: Piranha 
 
7. My name starts with “L”.  I can make my body light up.  I have very large eyes.  Who am 

I?  Answer:  Lanternfish 
 
8. My name starts with “C”.  I am a colorful, striped fish that lives near poisonous sea 

anemones.  Who am I?  Answer: Clown fish 
 
9. My name starts with “R”.  I am a flat fish.  I have no bones.  Who am I?  Answer:  Ray 
 
10. My name starts with “W”.  I am the biggest fish in the world, but I eat tiny fish and 

sea creatures.  Who am I?  Answer: Whale Shark 

Copyright  2003  i3 Inc.                                          inspiring, innovative, integration                                                       Day 3                     
 



Curriculum and Technology Integration Training                                                  Trainers Manual  
 

• 

• 

• 
• 

• 
• 

• 

• 
• 

• 

My Riddle – Day 3 - page 20 
 
Trainer Notes – Storyboard sheet for My Riddle. 

Participants are to create a riddle about their sea creature using the facts from 
Fact Gathering sheet, page 16.   
Use the storyboard to sketch a picture of the sea creature.  The face of the sea 
creature will be the participant.  The digital picture that the Trainer took will be 
used. 

The following steps are done with the participants’ hands on their computers. You will walk 
them through creating their riddle and illustration using the draw tools in KidPix.  

Open the KidPix software and enter your name. Click “Go” 
Move your cursor up to the top of the screen to reveal a set of hidden drop down 
menus. 
Click on the “Add” menu and choose “Add a graphic”  
Guide participants to the place where you stored the digital pictures you took of 
them earlier in the day. Participants should choose their picture and click on “Open” 
The graphic you chose will now be on your screen. Remember middle moves and 
corners resize. Adjust your image on the page. Tell participants that they will be 
creating a picture of their creature with their face as the face of the creature. 
Show the following tools, eraser, pen/pencil, color splash and text tool.  
Allow participants to draw themselves as their creature and then type their riddle 
on the page.  
Save and print these out so they can be posted in the room. 
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My Riddle 
 
 

Write your own Who am I riddle. 
 
My name starts with ______________.   
 
 
I am 

 
_____________________________________________________________ 
 
 
Who am I?   
 
Answer:  
 
____________________________________________ 
 
Sketch: 
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Comparing & Contrasting Creatures From the Deep  
Day 3 - page 21 

 
Trainer Notes – Comparing & contrasting using a Venn diagram 
 
Participant Objectives – 

Creating a Venn diagram template using Microsoft Word or AppleWorks. 
 
Student Objectives – 

Knowing the differences and similarities between ocean animals. 
 
Materials Needed –  

Microsoft Word or AppleWorks 
CD ROMs, Internet, Imagination Express – Oceans 
Venn Diagram – page 23 

 
Trainer Talking Points -  

See steps under Procedures 3-5 on page 22 Day 3 
To complete this activity we will be using the facts that were gathered during the 
Creatures from the Deep lesson page 16. 
Participants are to locate a classmate who has a sea creature on a different color 
paper. 
Participants are to use page 23, Venn diagram to compare and contrast their two sea 
creatures. 
See steps under 3-5 Procedures, page 22 Day 3 

 
Creating a Venn Diagram Template Steps -  

Trainer is to follow the steps on page 24 – 25 taking the participants through the 
process of creating a Venn diagram template. 
You are creating the Venn diagram template to learn the draw tools in Microsoft 
Word. 
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Comparing & Contrasting Creatures From the Deep 
Teaching 

Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Questions for Teachers: How do I create a Venn Diagram template 
in Microsoft Word or AppleWorks? 
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                             Venn Diagram 
Essential Question: What are the differences and similarities 
between ocean animals? 

  
Learning Standards (State of Michigan): 
English Language Arts Standard 3: Later Elementary  
Integrate listening, speaking, viewing, reading, and writing skills 
for multiple purposes and in varied contexts.  
 
English Language Arts Standard 3: Early Elementary  
Integrate listening, speaking, viewing, reading, and writing skills 
for multiple purposes and in varied contexts.  
 
Science Standard I.1: Elementary 
Develop strategies and skills for information gathering and 
problem solving.  
(Tools: Sources of information, such as reference books, trade 
books, periodicals. Real-world contexts: Seeking help from peers, 
adults, libraries, other resources.) 
 
Science Standard III.5: Elementary: 
Describe the basic requirements for all living things to maintain 
their existence. ( Key concepts: Needs of life-food, habitat, 
water, shelter, air, light, minerals. Real-world contexts: Selected 
ecosystems, such as an aquarium, rotting log, terrarium, 
backyard, local pond or wetland, wood lot.) 
 
Materials: 
Venn diagram storyboard, Venn diagram template created in 
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Comparing & Contrasting Creatures from the Deep  
Day 3 - page 22 

 
Trainer Notes – Comparing and Contrasting lesson using a Venn Diagram template 
continued. 
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Teaching 
Strategies 
Modeled 
 
 
 
 
 
 
 
 
 
Whole Group 
Instruction 
 
 
Whole Group 
Discussion 
 
 
Partner 
Activity 
 
 
 
 
 
 
 
 
Whole Group 
Instruction 
 
 
Partner 
Activity 

Technology 
Strategies 
Modeled 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
AppleWorks 
or Microsoft 
Word 
 
Download 
free teacher 
resources and 
reproducibles 
from 
Microsoft- 
http://www.t
echlearning.co
m/db_area/a
rchives/WCE
/archives/su
mner3.htm  
 
CDs, 
Imagination 
Express: 
Ocean, 
Internet 
 
 
AppleWorks, 
Microsoft 
Word 

Microsoft Word or AppleWorks, Reference CD-ROMs, Trade 
books, Internet  
 
Technology Connection: 

Microsoft Word, AppleWorks, Imagination Express: Oceans, 
Reference CD-ROMs, Internet 
 

Procedures: 
Procedures:  K-2 

• Introduce comparing and contrasting with a Venn diagram, 
whole group.  Model comparing and contrasting using a Venn 
diagram. 

• Brainstorm characteristics of two different creatures from 
the deep. 

• Chart facts about the two creatures. 
• Students compare and contrast the creatures with a partner 

using a Venn diagram storyboard.   
• Using Venn diagram template (AppleWorks or Microsoft 

Word), students compare and contrast the two creatures of 
the deep.  

• Print the completed Venn diagram. 
     
    Procedures: 3-5 

• Introduce comparing and contrasting with a Venn diagram, 
whole group.  Model comparing and contrasting using a 
Venn diagram. 

• Students are paired, each selecting a different creature 
of the deep. 

• Students gather facts about their creature of the deep 
using reference CD- ROMs, Imagination Express: Ocean, 
Internet and trade books. 

• Students compare and contrast their creature of the deep 
with their partner using a Venn diagram storyboard.   

• Using Venn diagram template (AppleWorks, Microsoft 
Word), students compare and contrast the two creatures 
of the deep.  

• Print the completed Venn diagram. 
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Venn diagram Storyboard – Day 3 - page 23 
 

Trainer Notes – Participants are to use this storyboard to compare and contrast their sea 
creature with another classmate’s sea creature.  This is also an example of a storyboard 
participants will create using the draw tools in Microsoft Word. 
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Venn diagram Steps – Day 3 - page 24 
 

Trainer Notes – Trainer and participant will follow these steps to create a Venn diagram 
template.   
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Venn Diagram Steps 
Setting Up 
• Open Microsoft Word 
• Change the page layout 
• Click on the File menu and select page setup. 
• Click on the Paper size tab. 
• Under Orientation, click the bullet box beside Landscape. 
• Click OK. 
• Change the Zoom. 
• Click the drop down list indicator beside 75% on the right side of the toolbar.   
• Select 50%. 
• Make sure your drawing tool bar is showing. 
• Click on the View menu and select Toolbars. 
• If Drawing is not checked, click on Drawing.  If it is, click off. 
 
Making the Venn diagram 
• Draw a circle 
• Select the Oval tool on the drawing toolbar. 
• Hold the shift key while clicking and dragging a circle on the left half of the page. 
• Make a copy for a matching circle. 
• Click once on the circle to select it.  (It will have handlebars if it is selected.)   
• Right click and select copy. 
• Click off of the circle.  Right click and select paste. 
• Move the new circle over to the right of the page by clicking and dragging so that the 

new circle overlaps the original, allowing room to enter similarities in the overlapping 
area. 

• Set the Circle for No Fill. 
• Right click on the Right circle. 
• Select Format AutoShape. 
• Under Fill, beside Color: Use the drop down list indicator and select No Fill. 
• Click OK. 
• Draw lines for each animal name. 
• Select the line tool from the Drawing toolbar. 
• Hold Shift while you click and drag a straight line just outside of the upper left of the 

left-hand circle. 
• With the line selected (handlebars on each end of the line) click the Edit menu and 

select copy.  Click again on the edit menu and select paste. 
• Click and drag the new line just outside the upper right of the right-hand circle. 
• Add text boxes 
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• Select the Text Box tool from the Drawing toolbar. 
• Click and drag a text box above each label line, in each individual circle, and in the 

shared area.  Set the font style and size of your choice in each box.  (You will have to 
re-select the text box tool each time.) 

• Right click on the edge of each text box and select Format Text Box. 
• Under the line section on the Colors and Lines tab, change the color to No Line.  
• Click OK. 
• Add labels at the bottom of the diagram 
• Again select the text box tool from the Drawing toolbar. 
• Draw a text box under the left circle. 
• Set the font style and size and type “Different.” 
• Right click on the edge of the new text box.  Set the line color to No Line. 
• Draw 2 more text boxes; One for the middle section which will be “Same” and the other 

for the right-hand circle which will be “Different.” 
• Save the Venn Diagram as a template 
• Click on the File menu and select Save As. 
• Change Save as type to Document Template. 
• Change the file name to Venn Diagram. 
• Change the location to 3 ½ Floppy (A:) 
• Click Save. 
• Close out of Microsoft Word. 
 
Using the Venn Diagram Template 
• Open the Venn Diagram Template to enter information. 
• Double click on My Computer. 
• Double click on 3 ½ Floppy (A:). 
• Double click on Venn Diagram.dot 
• Click in the appropriate area to enter information. 
• Save the new Document 
• Click on the File menu and select Save. 
• Type in the name for the completed Venn Diagram. 
• Change to the appropriate drive and folder. 
• Click Save. 
• Close out of Microsoft Word. 
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Software Helpers – Day 3 - Page 26 – 32 
 

Trainer Notes - Software Helpers -  
The following Software Helpers are provided for Trainer and Participants: 

Imagination Express – Oceans page 27 
Kid Pix Studio Deluxe   page 28 – 29 
Microsoft PowerPoint   page 30 - 32 
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Software Helper  
Using Imagination Express Ocean 

 
Open the Imagination Express Ocean program. 
 
Click on Add Name and type your name.  Click Add, then OK. 
 
Locate information about underwater exploring.  Click on Fact Book.  Click on the button 
beside Exploring Underwater.  Click on the speaker button to hear it read.  Click on the 
stop button. 
 
Click on Sample E-book to show students the type of story they can create with 
Imagination Express. 
 
Create a new book.  Click on the green New button on the main control panel. 
 
Choose your background for the title page.  Click OK. 
 
Choose stickers to go on your page.  Click the blue arrows at the top to change the library.  
Click the arrows at the bottom to see more pictures in that library.  Click and drag the 
sticker to place it.  (Note that it changes its perspective as you move it around.) 
 
Animate your stickers.  Click on the animation button on the bottom (the one with the 
yellow dot).  Click on a sticker.  You can now animate, make larger, smaller, or rotate your 
sticker.  You can also record sound with a microphone. 
 
Learn information about your sticker.  In the animation box, you’ll see an open book in 
the upper left hand corner.  Click it to learn more information about your sticker.  Click 
the stop button to go back.  Close the animation window. 
 
Add text.  Click the text button on the bottom.  Type your title. Change the color, size and 
style at the top.  Drag the text box to position it.  Click on the screen to deselect the text 
box. 
 
Delete text or stickers by dragging them to the trashcan. 
 
Add a new page by clicking on the green new button at the bottom.   
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Software Helper 
    Kid Pix Studio Deluxe 

Main Drawing Program 
 
Pencil- Used for drawing, can choose fill color and thickness below 
 
Line- Used for making lines, hold down the shift key when drawing a line to make the line 
straight. 
 
Shape Tools- Used for making squares, rectangles, circles or ovals.  Hold down the shift 
key when drawing to make a perfect square or circle. 
 
Paint Brush- Used to create effects and shapes.   
 Symmetry tool:  Make symmetrical pictures 

Dot-to-dot tool:  Draw letters, numbers or a picture.  Change puzzles with 
classmates to complete. 
ABC text tool:  Go to toolbox and Alphabet Text to change the letters to a word 
and illustrate that word. 
Dice tool:  Have students “roll” dice and use the Alphabet stamp to put a sign in the 
middle and solve the problem. 
X & O tool:  Have students draw a tic-tac-toe grid with the line tool and play tic-
tac-toe with the X’s and O’s.  Draw a number of X’s and O’s ahead of time and place 
them using the moving van. 
Red Circle Shape tool:  Make a code using the shapes given, ex.  triangle=50¢; 
circle=25¢; cube=10¢; diamond=5¢; square=1¢.  Have students make a line of 3-6 
shape symbols and total up the amount spent.  Use the alphabet stamp to stamp the 
answer beside the problem. 
Six Ball Multiplication tool:  Have students create the beginning of a multiplication 
problem until they get to the equal  sign.  Have them stamp the answer using their 
alphabet stamp.  
Building tools:  Have kids use the door and window tools to make multiplication 
arrays.  Create the array with the door or window and make a multiplication problem 
to go with it using the alphabet stamps. 

 
Paint Bucket-  Used to create background color or to color  large areas. 
 
Mixer-  Used to make a variety of special effects 
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Eraser-  Used to erase mistakes.  The square shapes erase only a portion of the picture, 
the others erase the entire picture, excluding type. 
 
Alphabet Stamps-  Used for stamping letters, numbers and symbols. 
 
Typewriter-  Used to type; change font and size at the bottom of the screen.  To edit 
typing, click inside the text box and make changes. 
 
Stamps-  Can change stamp set by going to goodies and pick a stamp set.  Make stamps 
larger by pressing the control button, extra-large by pressing control and shift. 
 
Moving Van-  Selects and moves portions of a picture. 
 
Undo-  Undoes the last operation that you have done 
 
Creating a Kid Pix Slide Show 
 
1.  Create your picture in Kid Pix and save them to a disk or your hard drive. 
 
2.  Open the Slide Show creator. 
 
3.  Push the picture button on the bottom of the first truck to import your saved picture. 
 
4.  Choose any sounds you wish to include and the transition between your first and second 
slide.   
 
5.  Continue the process for each slide. 
 
6.  When done,  click on goodies and play once or play looped to view your slide show. 
 

7.  To save, click on File and Save as a slide show.  To view your show on a computer that 
does not have Kid Pix installed, choose save as a stand-alone.   
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Software Helper 
POWERPOINT 

 
Getting Started: 
Auto Content Wizard- Gives you a head start on a presentation with a fill-in-the-blank 
type of form.  Choose from pre-made presentations on a variety of subjects. 
 
Template- Allows you to start your presentation with a pre-made background for each 
slide. 
 
Blank Presentation- Start your own presentation with a white background.  To set the 
background color click on Format and Background.  Click on Format and Apply Design to 
choose a template background. 
 
Creating a Slide: 
Choose an Auto Layout-   

• Choose a layout for your slide.   
• If you need to go back and add something else later, you can click on Insert and 

the item that you wish to add. 
 
Adding Text-   

• Click on the text box to begin typing.   
• Click on the top toolbar or Format and Font to make changes.   

 
Adding Graphics-   

• Click on the graphics box if you selected an auto layout.   
• If you wish to add a graphic box to an existing slide, click on Insert and picture.  

Double click on the picture to select it.  Once on the slide, you can click on it and 
drag it into position or click on the corners to size it. 

 
Inserting a Chart-   

• Click on Insert and Chart.  Enter your data in the table.   
• To change the orientation of your chart, click on Data and Series in Rows or 

Series in Columns.   
• To change the type of graph, click on Chart and Chart Type.   
• Chart and Chart Options allows you to label the X and Y-axis. 
• Chart and 3-D view changes how the shadowing on the chart appears. 
• View and Datasheet allows you to go back and make changes to your data. 
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Inserting a Table or Spreadsheet- 

• Click on the table button on the top tool bar. 
• Choose the size of your table. 
• Click to type in each cell. 
• If you want a more polished look, click on Table and Table Auto Format.  There 

are many templates to use as a starting point. 
• If you wish to enter a formula into a cell in a spreadsheet, click on Table and 

Formula.  Remember all formulas must begin with an equal sign. 
• Table and Merge combines selected cells and puts them together to make one 

larger cell. 
• Table and Split separates the selected cell into parts. 

 
Inserting Shapes- 

• Click on Auto Shapes at the bottom tool bar. 
• Choose the shape you wish to include. 
• Click beside the Paint Bucket to change the fill color and click on the paintbrush 

to change the line color. 
• Click on the A to begin typing in that shape and click on the arrow beside to 

change the color. 
• Click on the 3-D cube picture to change how the shape appears on the screen. 

 
Inserting Word Art- 

• Click on the 3-D letter A at the bottom tool bar.   
• Select a style for your text. 
• Type in your text and click OK. 
• Size your text by clicking on the corners and dragging. 

 
Putting on the Finishing Touches 
Adding Animation Effects- 

• Open the slide to which you wish to add effects. 
• Click on the first element that you wish to appear on your slide. 
• Click on the animated star at the top of the tool bar. 
• Choose an effect for your element.  Click preview to see how it works. 
• Do the same with each element on the slide. 
• To preview your slide, click on Slide Show and Animation Preview. 

 
Choosing a transition- 

• Click on Slide Show and Slide Transition. 
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• Choose a transition, speed and when you want it to appear or move to the next 

slide. 
• Click apply to set the transition for that one slide, click apply to all to choose 

that transition for all of the slides. 
 
Adding Action Buttons- 

• Click on Slide Show and Action Buttons. 
• Action Buttons allow you to create a link to another slide, the Internet, sound 

clip or video. 
 
Check your Spelling- 

• Click on the Check ABC button on the top tool bar to check spelling on all of your 
slides. 

 
Presenting Your Show 
Speaker Notes- 

• Click on View and Speaker Notes to write notes for yourself to review as you give 
your presentation.  You will need to print these notes out, as you will not be able 
to see them when you give your presentation. 

 
Rehearsing Timings- 

• Click on Slide Show and Rehearse Timings to pull up your screen and see a 
stopwatch. 

 
Set up the Show- 

• Click on Slide Show and Set up Show to enter your preferences for how to show 
will advance.   

• You can change the color of the pen and how you want it to appear. 
 
Viewing Your Show- 

• Click on Slide Show and View Show to view your show.   
• If you wish to exit the show before it is over hit your escape button on the 

keyboard. 
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Supplemental Lesson Plans  – Day 3 - page 33 – 49 
 

Trainer Notes – Supplemental Lesson Plans 
The Crazy About Coral lesson plan is a supplemental lesson.  If you are going to model 
this lesson, follow the step-by-step procedures and make use of the storyboards and 
assessments. 
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Lesson 
Plans  
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Crazy about Coral 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Questions for Teachers:  How do I export a picture from KidPix?  
How do I create an Inspiration template?  How do I create a Power Point 
presentation? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Essential Question: What is coral?  Is it a plant or an animal?  
What are some different types of coral? 
 
Learning Standards (State of Michigan): 
Assessed: English Language Arts Standard 3: Early 
Elementary  
Employ strategies to construct meaning while reading, listening 
to, viewing, or creating texts. Examples include retelling, 
predicting, generating questions, examining picture cues, 
discussing with peers, using context clues, and creating mental 
pictures. 
 
Science Standard II.1: Elementary 
Show how science concepts can be interpreted through creative 
expression such as language arts and fine arts. ( Key concepts: 
Poetry, expository work, painting, drawing, music, diagrams, 
graphs, charts. Real-world contexts: Explaining simple 
experiments using paintings and drawings; describing natural 
phenomena scientifically and poetically.) 
 
Science Standard III.4: Elementary 
Explain how physical and/or behavioral characteristics of 
organisms help them to survive in their environments. ( Key 
concepts: Characteristics-adaptation, fitness, instinct, learning, 
habit . Traits and their adaptive values-sharp teeth or claws for 
catching and killing prey, color for camouflage. Real-world 
contexts: Common vertebrate adaptations, such as white polar 
bears, sharp claws and sharp canines for predators, changing 
colors of chameleon; behaviors, such as migration, communication 
of danger, adaptation to changes in the environment.) 
 
Materials: Student reproducibles, Inspiration, KidPix, Internet, 
scan converter, Power Point 
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Teaching 
Strategies 
Modeled 
 
 
 
 
 
 
 
 
 
 
 
 
Whole 
Group 
Instruction 
 
 
 
 
 
 
Individual 
Activity 
 
 
Whole 
Group 
Discussion 
 
 
 
 
Individual 
Activity 
 
 
 
 
 
 
 
 
Whole 
Group 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Internet- 
http://www.un
cwil.edu/nurc/
aquarius/lesso
ns/coral_reef
/coral1.htm 
 
Internet 
“Cruises”- 
http://www.te
chlearning.co
m/db_area/ar
chives/WCE/a
rchives/heesc
ruz.htm  
 
Internet- 
http://islandf
un.com/dive/c
oralcard.htm 
 
KidPix 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Technology Connections: Students will learn information about 
the Coral Reef from a CD.  They will then identify different 
types of coral using the Internet and will create a picture in 
KidPix, showing what they have learned.  They will reinforce this 
new learning in a center, completing an Inspiration Template.  In 
grades 3-5, students will work with a group to create a 
PowerPoint presentation. 
 
K-2 Procedures: 
Introduction 
1. View the Electronic Book, Dive to the Coral Reefs. 
2. Give each student a Dive to the Coral Reef sheet to complete 

as you go through the book.  Stop to discuss topics as needed 
and to view videos in the book. 

 
Diving Deeper 
1. Give each student a set of coral identification cards.  Discuss 

what each coral looks like from their point of view.  Have 
students predict the names of each coral. 

2. Using a scan converter, show the coral at 
http://islandfun.com/dive/coralcard.htm.  Use those pictures 
to identify the names and write them on the coral cards.  
Discuss with students why each coral has the name it does. 

3. Next, have students draw a picture of a coral reef in KidPix 
using their coral cards as guides. Show them how to use the 
pencil to draw a shape and how to use the paint bucket to fill 
it in.  Ask students to draw three different coral in their 
pictures and label them.  Show them how to change the stamp 
set and locate the stamps entitled “Nature” to add other sea 
life. 

4. Save the slides on a disk and use them to create a class slide 
show using the directions that follow.  Share this show with 
the class, allowing students to present their slide as it comes 
up. 

5. Assess their individual pictures with the rubric and student 
self-evaluation. 
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Teaching 
Strategies 
Modeled 
 
 
Center 
Activity 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Whole 
Group 
Instruction 
 
 
 
 
 
 
Cooperative 
Groups 
 
 
 
 
Small 
Groups 
 
 
 
 
 
 
 
 
 
 
 

Technology 
Strategies 
Modeled 
 
 
 
Inspiration 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Internet- 
http://www.un
cwil.edu/nurc/
aquarius/lesso
ns/coral_reef
/coral1.htm 
 
 
 
 
 
 
 
 
 
 
KidPix 
 
Internet 
“Cruises”- 
http://www.te
chlearning.co
m/db_area/ar
chives/WCE/a
rchives/heesc
ruz.htm 
 
Internet- 
www.yahooliga
ns.com 

Reinforcing the concept 
1. Reinforce the information that students have learned with 

this center activity.   
2. Create an Inspiration template according to the directions 

that follow.   
3. Ask students to bring their coral cards to the computer with 

them during center time, and ask them to complete the 
Inspiration web by clicking and typing in the name of the coral 
underneath the picture. 

4. Have students print their completed web and turn it in for 
evaluation. 

 
3-5 Procedures: 
Introduction 

1.  View the Electronic Book, Dive to the Coral Reefs. 
2. Give each student a Dive to the Coral Reef note-taking 

sheet to complete as you go through the book.  Stop to 
discuss topics as needed and to view videos in the book. 

 
Diving Deeper 

3. Gather students into cooperative groups.  Allow each 
student to pick a coral group card.  Those students who 
have the same coral will be grouped together.  Groups 
should be no larger than 2-3 students.   

4. With their group, have students draw a picture of a coral 
reef in KidPix.  Show students how to use the pencil to 
draw a shape and how to use the paint bucket to fill it in.  
Show them how to change the stamp set and locate the 
stamps entitled “Nature” to add other appropriate sea life.  
Ask students to draw three different coral in their 
pictures.   

5. Show students how to save their picture to a disk for use 
in the following Power Point activity.   

6. Now, ask students to do a search in Yahooligans 
(www.yahooligans.com) to gather more information about 
different three different types of coral.  Ask students to 
complete the fact-gathering sheet to guide their 
research.  Show students how to save graphics from the 
Internet to a disk for use in the slide show. 
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Teaching 
Strategies 
Modeled 
 
 
 
 
 
 
Small 
Groups 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Center 
Activity 

Technology 
Strategies 
Modeled 
 
 
Search Tools 
for Students- 
http://www.te
kmom.com/sea
rch/index.htm
l  
 
 
Power Point 
 
On-line 
tutorial for 
Power Point- 
http://www.ac
tden.com/pp/  
 
 
 
 
 
Inspiration 

7. Using the storyboard, ask students to create a slide show 
with four slides.  On the first slide, students will import 
their saved Coral Reef picture from KidPix and create a 
title for their show.  On the remaining three slides, have 
students include a graphic and two facts about a type of 
coral.   

8. Using the storyboard as a guide, ask students to complete 
their Power Point slide show.  Share the completed shows 
with the class. 

9. After students have completed their project, ask them to 
evaluate their own show with the checklist found at 
http://pblchecklist.4teachers.org/view.php3?id=2147.   

 
Reinforcing the concept 

10. Reinforce the information that students have learned with 
this center activity.   

11. Create an Inspiration template according to the directions 
that follow.   

12. Have a supply of Coral Reef reference books available by 
the computer.  Allow students to look through the 
reference books to identify the different types of coral.  
Once a student identifies the coral, have them click in the 
blank below the picture to type in the type of coral 

13. Have students print their completed web and turn it in for 
evaluation. 

 
Assessment: K-2:  Students’ answers to the fill-in-the-blank 
Dive to the Coral Reefs sheet will be assessed for accuracy.  
Their KidPix pictures will be evaluated with a rubric, and their 
Inspiration coral web will be assessed for correct spelling and 
identification. 
3-5: Students’ completed Power Point presentation will be 
evaluated with a rubric.  Their fact-gathering sheets can also be 
evaluated for accuracy. 
 
Extension: Have students create a Power Point presentation that 
contains information about coral reef habitats around the world.   
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Dive to the Coral Reef 
 

Write notes on the lines below about the following topics as you learn 
information from the electronic book. 
 
Great Barrier Reef   staghorn coral   brain coral 

sea turtle     sharks    skeleton 

octopus     plate coral    sea fans 

tentacles    sea whips     barracuda 
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Dive to the Coral Reef 
 

Word Bank: 
 
Great Barrier Reef  staghorn coral  brain coral 

sea turtle    sharks   skeleton 

octopus    plate coral   sea fans 

tentacles   sea whips    animals 

barracuda      

     
 

1. The largest coral reef is the ______________________________. 
 
 

2. A coral eats by waving its ______________ around. 
 
 

3. Corals are not plants, they are _________________. 
 
 

4. Corals use their hard _____________________ for protection. 
 

5. Some names of hard coral are: 
 

______________   ______________        ______________ 
 

6. Some names of soft coral are: 
 

______________        ______________ 
 

7. Some other animals that live there are: 
 

______________           ______________ 
 

______________    ______________ 
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I am a _____________ coral. 
 
I’m called that because 
____________________________________
_________________________.__________ 

I am a _____________ coral. 
 
I’m called that because 
_____________________________________
_________________________.___________ 

I am a _____________ coral. 
 
I’m called that because 
_____________________________________
_________________________.___________ 

I am a _____________ coral. 
 
I’m called that because 
____________________________________
_________________________.__________ 
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Crazy About Coral 
Name: 
CATEGORY  Excellent  Good  Satisfactory  Needs 

Improvement  

Mechanics  No misspellings 
or grammatical 
errors.  

Three or fewer 
misspellings 
and/or 
mechanical 
errors.  

Four misspellings 
and/or 
grammatical 
errors.  

More than 4 
errors in spelling 
or grammar.  

Graphics  Required graphics 
are included on 
each slide.  They 
are appropriate 
and relevant to 
the topic. 

Required graphics 
are included on 
each slide, but 
may not always be 
appropriate or 
relevant to the 
topic. 

Required graphics 
are included on at 
least 3 slides, but 
some are not 
appropriate or 
relevant to the 
topic. 

Required graphics 
are missing.  
Graphics that are 
included are not 
relevant to the 
topic.  

Requirements  All requirements 
are met and 
exceeded.  

All requirements 
are met.  

One requirement 
was not 
completely met.  

More than one 
requirement was 
not completely 
met.  

Content  Covers topic in 
depth with 
details and 
examples. 
Subject 
knowledge is 
excellent. 

Includes 
essential 
knowledge about 
the topic. 
Subject 
knowledge 
appears to be 
good.  

Includes 
essential 
information about 
the topic but 
there are 1-2 
factual errors.  

Content is 
minimal or there 
are several 
factual errors.  

Organization  Content is well 
organized using 
headings or 
bulleted lists to 
group related 
material.  

Uses headings or 
bulleted lists to 
organize, but the 
overall 
organization of 
topics appears 
flawed.  

Content is 
logically 
organized for the 
most part.  

There was no 
clear or logical 
organizational 
structure, just 
lots of facts.  
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Crazy About Coral 

Circle a smiley face if you completed each of the requirements on your 
Coral Reef picture in KidPix. 

 
 

 
 I drew three pictures of coral. 

 
 
 

 I used the paint bucket to color my picture. 
 
 
 

 I added coral reef animal stamps to my picture. 
 
 
 

 I labeled each of my coral pictures with the typewriter tool. 
 
 
 

 I put my name on my picture. 
 
 
 

 This is my very best work. 
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Crazy About Coral 
A smiley face indicates that you have completed the required element. 
 

 You drew three pictures of coral. 
 
 
 

 You used the paint bucket to color your picture. 
 
 
 

 You added coral reef animal stamps. 
 
 
 

 You labeled each of your coral pictures. 
 
 
 

 All of the words are spelled right. 
 
 
 

 This is your very best work. 
 
 
 
 
Teacher Comments: 
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Web Search Fact-Gathering Sheet 

Use Yahooligans to locate more information about different types of coral.  Locate 
information and graphics for three different types of coral and record facts on the space 
below. 
 
Name of Coral Location/Habitat Facts Name/Location of Graphic 
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Title Slide 
(includes KidPix graphic) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slide #1 
(includes 2 facts and graphic from Internet) 

Slide #2 
(includes 2 facts and graphic from Internet) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slide #3 
(includes 2 facts and graphic from Internet) 

Copyright  2003  i3 Inc.                                          inspiring, innovative, integration                                                       Day 3                     
 



- 46 -                    Water, Water Everywhere! 
Curriculum & Technology Integration Training 

 

- 46 -                    Water, Water Everywhere! 
Curriculum & Technology Integration Training 

 

Day 3                                                        inspiring, innovative, integration                                          Copyright  2003  i3 Inc. 
 

Coral Group Cards 

Day 3                                                        inspiring, innovative, integration                                          Copyright  2003  i3 Inc. 
 



Water, Water Everywhere!                - 47 - 
Curriculum & Technology Integration Training  
   

Creating the Coral Web Template in Inspiration 
 
1. Open up a new Inspiration document. 
2. In the Main Idea space, type “Types of Coral”. 
3. Click on the circle so you see the red boxes appear around the main idea, and click on 

Format and change the font, size and style to your preference. 
4. Now click on that space and click on one of the create arrows at the toolbar at the top.   
5. Click back on the main idea and keep creating more links from it.  Your web should now 

look something like this:  
 
6. Minimize that screen and go into your Internet program.  Go to the following internet 

site and copy a graphic to your computer’s clipboard (click and hold for Mac, right click 
for PC, then choose copy). http://islandfun.com/dive/coralcard.htm 

 
7. Now go back to the web and click on one of the blue ovals that you made.  Click on Edit 

and Paste and your new graphic will appear. 
 
8. Repeat for each of the other graphics. 
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9. Now you will want to change the size of the type for your students when they type 

their words under the pictures.  Press your shift key on the keyboard and hold it down 
while you click on each of the coral pictures on the web.  There should be red boxes 
around each of the pictures.  Click on Format and change the size to 14 pt. 

 
10. Your web should now look something like this: 

 
11. To save your web as a template, click on File and Save as Template.  Now type the name 

under which you want it to be saved.  Click OK. 
 
12. To retrieve your saved template click on File, Template and scroll down until you see 

the name of your template.  Click on it an click Open. 
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• 

Types of 
Coral
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1. Name a  search engine, a directory and a meta search tool? 
 
 
 
2. What is an itList? 
 
 
 
 
3.  Name 3 of the tools in KidPix? 
 
 
 
 
4.  What key do I hold down create a perfect circle or line in Word? 
 
 
 
 
5.  How do I create a template in Word? 
 
 
 
5. What is “Boolean” logic? 
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Brain Check  – Day 3 - page 50 
 
Trainers Notes – Brain Check 
The Brain Check should be adapted by each Trainer to match the selected software 
used in the training. 
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Daily Closure  
 

Trainer Notes –  
• Recap the day.  
• Take questions that participants have.  
• Assign Homework 
• Have participants straighten up their area. 
• Shut down computers 
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